Chapter 681

Sample Size of a Pilot Study using the Upper Confidence Limit of the SD

Introduction

This routine obtains the sample size of an external pilot study by trying to minimize the combined sample size of both the pilot study and the main study. The sample size of the main study is estimated using an upper confidence limit (UCL) of $\sigma$ calculated from the pilot data.

There is a trade-off. As the pilot study size is increased, the main study size based on the UCL is decreased since the UCL is smaller. There is usually a pilot size that minimizes the total sample size.

Browne (1995), Kieser and Wassmer (1996), and Machin et al. (2018) point out that using the standard deviation from a small pilot study directly in sample size calculations tends to result in under-powered studies. They indicate that if $s$ is replaced by $s_{UCL}$, where $s_{UCL}$ is the 100 $\gamma$% upper confidence limit of $s$, before the sample size calculations are made, the probability that the planned power of the main trial is achieved is about $\gamma$. Whitehead et al. (2016) outlines an algorithm to determine the optimum value of the pilot study. Note that this paper also presents an alternative algorithm based on the non-central t distribution that results in much smaller sample sizes. This other algorithm is also available in PASS.

Technical Details

Upper Confidence Limit (UCL) of $\sigma$

Suppose a pilot study results in an estimate $s_{Pilot}$ of $\sigma$. The 100 $\gamma$% UCL is given by

$$UCL(\gamma, df) = \frac{df}{\sqrt{\chi^2(1 - \gamma, df)}} s_{Pilot} = M s_{Pilot}$$

where $df$ is the degrees of freedom of $s_{Pilot}$ and $\chi^2(1 - \gamma, df)$ is the 1 $-$ $\gamma$ percentile of the Chi-squared distribution with $df$ degrees of freedom. In a two-group trial, $df = N1 + N2 - 2 = N_{Pilot} - 2$.

Thus, the estimate of $\sigma$ that is used in the sample size calculation of the main trial is given by inflating the standard deviation obtained from the pilot study by the inflation factor $M$. 

Machin et al. (2016) provide a common approximation for the determining the sample size of the main trial.

\[
N_{MAIN} = \frac{(R + 1)^2 \left( z_{1-\beta} + z_{1-\alpha/2} \right)^2}{R \left( \frac{\delta}{M^{SPilot}} \right)^2} + \left[ \frac{z_{1-\alpha/2}^2}{2} \right]
\]

The overall trial size is given by

\[N_{TOTAL} = N_{PILOT} + N_{MAIN}.\]

\[N_{TOTAL}\] can be minimized by a brute-force search of values of \[N_{PILOT}\], beginning at 3. This gives an optimum value of the sample size of the pilot study.

### Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

#### Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

**Solve For**

**Solve For**

This option specifies the parameter to be solved for from the other parameters.

#### Pilot Study

**\[N_{PILOT}\] (Pilot Sample Size)**

Enter one or more values of the confidence level percentage. Usually, this value is set at 80, 90, or 95. Enter one or more values for the sample size of the pilot study (\[N_{PILOT}\]). This is the total number of subjects in the two groups of the pilot study. This value will be used to estimate the combined sample size of the pilot study and the main study. That is, to calculate \[N_{TOTAL} = N_{PILOT} + N_{MAIN}\].

You can enter any value > 2. Usually, a value between 10 and 300 is used. One study of clinical trials using means found the median pilot study size to be 30.

You may enter a single value such as ‘24’, a range of values such as ‘20 to 60 by 2’, or a list of values such as ‘10 30 80 90’.

**\[s\] (SD Anticipated from Pilot Study)**

Enter an estimate of the standard deviation to be obtained in the pilot study. Use the best estimate of \(\sigma\) that you have available before the pilot study is conducted.

The range is any value greater than zero. If you want to use standardized values for the effect size, enter a ‘1’ here and use a standardized effect size (less than one) for \(\delta\).

You can enter a single value such as ‘2’ or a series of values such as ‘1 2 3’ or ‘1 to 10 by 1’.

Press the \(\sigma\) button to load the Standard Deviation Estimator window.
**CL (Confidence Level of UCL of σ)**

Enter one or more values of the confidence level of the one-sided upper confidence limit (UCL) of σ that will be obtained from the pilot study. These is entered as percentages.

Usually, this value is set at 80, 90, or 95. The range is 50 < CL < 100.

---

**Main Study**

**Power of Main Study**

This is the power of the test used in the main study. It does not apply to the pilot study.

Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1 - Beta, so specifying power implicitly specifies beta.

Beta is the probability of obtaining a false negative with the statistical test. That is, it is the probability of accepting a false null hypothesis.

The valid range is 0 to 1. Usually, the chosen power is between 0.8 and 0.99.

Different disciplines have different standards for setting power. The most common choice is 0.90, but 0.80 is also popular.

You can enter a single value such as 0.90 or a series of values such as 0.70 0.80 0.90 or 0.70 to 0.90 by 0.05.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

**Alpha of Main Study**

This is the alpha (significance level) of the test used in the main study. It does not apply to the pilot study.

Alpha is the probability of obtaining a false positive with the statistical test. That is, it is the probability of rejecting a true null hypothesis.

The null hypothesis is usually that the parameters of interest (means, proportions, etc.) are equal.

Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.10. Alpha is often set to 0.05 for two-sided tests and to 0.025 for one-sided tests.

You can enter a single value such as 0.05 or a series of values such as 0.05 0.10 0.15 or 0.05 to 0.15 by 0.01.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

**R (Allocation Ratio in Main Study)**

Enter one or more values of the allocation ratio (N1 / N2) of the sample sizes of the groups in the main study. The pilot study is assumed to have equal group sizes.

R must be positive. Usually, R is between 0.2 and 5 with '1' being by far the most frequently used value.

An R of one (equal group sizes) will result in the smallest sample sizes.

**δ (Mean Difference in Main Study)**

Enter the detectable difference (δ = μ1 - μ2) to be used in the main study. This parameter is not used in the pilot study. Note that the scale of this value must match the scale of the standard deviation.

The range of this parameter is any value other than 0.

If you want to use standardized values for the effect size, enter a '1' for s and use a standardized effect size (less than one) for δ.

Cohen (1988) gave the following interpretation of d = δ/σ values that is still common: small 0.2, medium 0.5, and large 0.8.

You can enter a single value such as 0.5 or a series of values such as 0.2 0.5 0.8 or 0.2 to 1 by 0.1.
Example 1 – Calculating the pilot study sample size

Suppose you want to find appropriate pilot study sample sizes when $s = 1$, CL = 80, power = 0.8, alpha = 0.05, $R = 1$, and $\delta = 0.2$ to 1.0.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Sample Size of a Pilot Study using the Upper Confidence Limit of the SD procedure. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu of the procedure window and choosing Open Example Template.

**Option** | **Value**
--- | ---
Design Tab | 
Solve For | $N_{\text{Pilot}}$ (Pilot Sample Size)
$s$ (SD Anticipated from Pilot Study) | 1
CL (Confidence Level of UCL of $\sigma$) | 80
Power of Main Study | 0.80
Alpha of Main Study | 0.05
$R$ (Allocation Ratio in Main Study) | 1.0
$\delta$ (Mean Difference in Main Study) | 0.2 to 1 by 0.2

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>$\delta$</th>
<th>CL</th>
<th>$N_{\text{Pilot}}$</th>
<th>$N_{\text{Main}}$</th>
<th>$N_{\text{Total}}$</th>
<th>$R$</th>
<th>Power</th>
<th>Alpha</th>
<th>$s$</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.20</td>
<td>80</td>
<td>77</td>
<td>912.0</td>
<td>989.0</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
<td>1.078</td>
</tr>
<tr>
<td>0.40</td>
<td>80</td>
<td>35</td>
<td>248.6</td>
<td>283.6</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
<td>1.126</td>
</tr>
<tr>
<td>0.60</td>
<td>80</td>
<td>23</td>
<td>118.6</td>
<td>141.6</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
<td>1.166</td>
</tr>
<tr>
<td>0.80</td>
<td>80</td>
<td>18</td>
<td>70.4</td>
<td>88.4</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
<td>1.198</td>
</tr>
<tr>
<td>1.00</td>
<td>80</td>
<td>14</td>
<td>48.3</td>
<td>62.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
<td>1.240</td>
</tr>
</tbody>
</table>

Report Definitions

$\delta = \mu_1 - \mu_2$ is the difference between the means. It is used to calculate the effect size ($\delta/\sigma$).

CL is the confidence level (percentage) of the one-sided confidence interval for the standard deviation from the pilot study.

$N_{\text{Pilot}}$ is the total sample size of the pilot study. This is what is being determined by this procedure.

$N_{\text{Main}}$ is the estimated total sample size of the main study.

$N_{\text{Total}}$ is the estimated combined sample size ($N_{\text{Pilot}} + N_{\text{Main}}$) of the both the pilot and the main study.

$R$ is the allocation ratio of the two groups being compared by the study. $R = N_1/N_2$.

Power is the probability of rejecting a false null hypothesis planned to be used in the main study.

Alpha is the probability of rejecting a true null hypothesis planned to be used in the main study.

$s$ is the standard deviation to be used for planning before the pilot study.

$M$ is the multiplier to inflate $s$ to its UCL for use as an estimate of $\sigma$ in the main trial planning.
Summary Statements

The optimum pilot sample size is 77 is anticipated to result in a total combined sample size in both the pilot and the main studies of 989.0. This is based on an upper confidence limit of $\sigma$ at the 80% confidence level with the power set to 0.800, the significance level (alpha) set to 0.050, the allocation ratio set to 1.000, the pilot standard deviation set to 1.00, and the detectable mean difference, $\delta$, set to 0.20.

This report shows the calculated multiple for each of the scenarios.

Plots Section

This plot shows the various values of the pilot sample size for various values of the detectable difference.
Example 2 – Validation using Machin et al. (2018)

Machin et al. (2018) page 267 give Table 16.5 which contains pilot sample sizes for various scenarios. We will duplicate the first column of this table as a validation example. In this example \( s = 1, \) \( CL = 80, \) power = 0.8, alpha = 0.05, \( R = 1, \) and \( \delta = 0.05, 0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.00. \) The corresponding pilot study sample sizes are 420, 176, 78, 48, 36, 28, 24, 20, 18, 16, 14. Note that the last three values are from Whitehead et al. (2016) page 1065 since Table 16.5 is reset 20 for sample sizes less than 20.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Sample Size of a Pilot Study using the Upper Confidence Limit of the SD procedure. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu of the procedure window and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Solve For: ( N_{\text{pilot}} ) (Pilot Sample Size)</td>
</tr>
<tr>
<td>Design Tab</td>
<td>( s ) (SD Anticipated from Pilot Study) ( = 1 )</td>
</tr>
<tr>
<td>Design Tab</td>
<td>CL (Confidence Level of UCL of ( \sigma )) ( = 80 )</td>
</tr>
<tr>
<td>Design Tab</td>
<td>Power of Main Study: 0.80</td>
</tr>
<tr>
<td>Design Tab</td>
<td>Alpha of Main Study: 0.05</td>
</tr>
<tr>
<td>Design Tab</td>
<td>( R ) (Allocation Ratio in Main Study) ( = 1.0 )</td>
</tr>
<tr>
<td>Design Tab</td>
<td>( \delta ) (Mean Difference in Main Study) ( = 0.05 \ 0.1 \ 0.2 \ 0.3 \ 0.4 \ 0.5 \ 0.6 \ 0.7 \ 0.8 \ 0.9 \ 1.0 )</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>( \delta )</th>
<th>Pct Conf Level</th>
<th>CL</th>
<th>Pilot Study Sample Size</th>
<th>Main Study Sample Size</th>
<th>Total Sample Size</th>
<th>Alloc Ratio N1/N2</th>
<th>Pilot SD Standard Deviation ( s )</th>
<th>Pilot SD Inflation Factor M</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.05</td>
<td>80</td>
<td>420</td>
<td>13340.4</td>
<td>13760.4</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.10</td>
<td>80</td>
<td>176</td>
<td>3454.5</td>
<td>3630.5</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.20</td>
<td>80</td>
<td>77</td>
<td>912.0</td>
<td>989.0</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.30</td>
<td>80</td>
<td>48</td>
<td>424.6</td>
<td>472.6</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.40</td>
<td>80</td>
<td>35</td>
<td>248.6</td>
<td>283.6</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>28</td>
<td>164.7</td>
<td>192.7</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.60</td>
<td>80</td>
<td>23</td>
<td>118.6</td>
<td>141.6</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.70</td>
<td>80</td>
<td>20</td>
<td>89.7</td>
<td>109.7</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.80</td>
<td>80</td>
<td>18</td>
<td>70.4</td>
<td>88.4</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>0.90</td>
<td>80</td>
<td>16</td>
<td>57.3</td>
<td>73.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
<tr>
<td>1.00</td>
<td>80</td>
<td>14</td>
<td>48.3</td>
<td>62.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
<td>1.00</td>
</tr>
</tbody>
</table>

PASS matches the first column to within rounding.
Example 3 – Calculating the total sample size for various pilot study sample sizes

Suppose you want to see the total sample sizes for various pilot study sample sizes when $s = 1$, $CL = 80$, power = 0.8, alpha = 0.05, $R = 1$, $\delta = 0.5$, and $N_{PILOT} = 6$ to 50.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Sample Size of a Pilot Study using the Upper Confidence Limit of the SD procedure. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu of the procedure window and choosing Open Example Template.

Design Tab

Solve For ................................................ $N_{TOTAL} \ (N_{PILOT} + N_{MAIN})$

$N_{PILOT}$ (Pilot Sample Size) .................... 6 to 50 by 2

$s$ (SD Anticipated from Pilot Study) ...... 1

CL (Confidence Level of UCL of $\sigma$) ........ 80

Power of Main Study............................ 0.80

Alpha of Main Study................................ 0.05

$R$ (Allocation Ratio in Main Study) .......... 1.0

$\delta$ (Mean Difference in Main Study) ........ 0.5

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>$\delta$</th>
<th>CL</th>
<th>Pilot Study Sample Size</th>
<th>Main Study Sample Size</th>
<th>Total Sample Size</th>
<th>Alloc Ratio N1/N2</th>
<th>Pilot Standard Deviation</th>
<th>Pilot SD Inflation Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.50</td>
<td>80</td>
<td>6</td>
<td>304.7</td>
<td>310.7</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>8</td>
<td>245.4</td>
<td>253.4</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>10</td>
<td>218.7</td>
<td>228.7</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>12</td>
<td>203.2</td>
<td>215.2</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>14</td>
<td>193.0</td>
<td>207.0</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>16</td>
<td>185.7</td>
<td>201.7</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>18</td>
<td>180.2</td>
<td>198.2</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>20</td>
<td>175.8</td>
<td>195.8</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>22</td>
<td>172.3</td>
<td>194.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>24</td>
<td>169.4</td>
<td>193.4</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>26</td>
<td>166.9</td>
<td>192.9</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>28</td>
<td>164.7</td>
<td>192.7</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>30</td>
<td>162.9</td>
<td>192.9</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>32</td>
<td>161.3</td>
<td>193.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>34</td>
<td>159.8</td>
<td>193.8</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>36</td>
<td>158.6</td>
<td>194.5</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>38</td>
<td>157.3</td>
<td>195.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>40</td>
<td>156.3</td>
<td>196.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>42</td>
<td>155.3</td>
<td>197.3</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>44</td>
<td>154.4</td>
<td>198.4</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>46</td>
<td>153.6</td>
<td>199.6</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>48</td>
<td>152.8</td>
<td>200.8</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.50</td>
<td>80</td>
<td>50</td>
<td>152.1</td>
<td>202.1</td>
<td>1.00</td>
<td>0.800</td>
<td>0.050</td>
</tr>
</tbody>
</table>
This report shows the estimated total sample size for each value of the pilot sample size. Note that the total sample size is a minimum of 192.7 when the pilot sample size is 28. If you refer back to Example 2, you will see that the optimum pilot size for $\delta = 0.5$ is indeed 28.

**Plots Section**

![Plot of N_{\text{total}} vs N_{\text{pilot}}](image)

This plot shows the various values of the sample sizes.